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Introduction

1.1 Purpose and Functions

The EIA-176 Query System is a PC-based system for users to produce reports and
extract data from the EIA-176 database that is used to produce the Natural Gas Annual.
Its purpose is to provide users with company-level data. This information is available in a
format similar to the survey form for individual companies, as well as in files suitable for
tabular calculation.

The query system has two functions. e The first is to provide individual company
responses in a form that resembles the EIA-176 survey form. This is viewable on-line,
and available in a printed form. Appendix A shows a sample EIA-176 form. Each
respondent is available in the year they reported data on the form EIA-176.

e The second function is to provide files of EIA-176 data for use with other software
packages. The query system provides two methods to obtain tabular data. (1) a set of 24
pre-selected queries. The information in these queries was designed to satisfy the bulk
of data requests received by the EIA. Appendix B outlines the pre-selected queries and
their data items. And;

(2) The second method is for user-selected queries. These queries offer users the ability
to access sets of data items not included in the pre-specified queries. Appendix C
outlines the available data items. Data in the pre-selected and user-selected queries
includes adjustment entries made by EIA staff to ensure that EIA-176 and publication
data balance.

Data sets from both query methods can be saved to separate files in a variety of popular
formats that include: text, comma-delimited for spreadsheets, SDF files for use with
dBase, and fixed width format for use in other software packages.

New in the pre-selected query section is a report of Name/Address data, a report

detailing individual company items shown in the continuation pages of the form, and LNG
activity.

EIA-176 Query System 1/26/04 - 3 0of 38



EIA-176 Query System User’s Guide 1/26/04)

1.2 Hardware and Software Requirements

The minimum hardware requirements needed to install and use the EIA-176 Query
System are:

eAn IBM-compatible personal computer (PC) — minimum Pentium 75 is suggested and 24
MB of RAM

eThe Windows operating system 95, 98, 2000, or NT —4.0 Service Pack 3 or later)
eInternet Explorer 5.0 or higher*

eAn 80-column monitor

¢15 MB of hard-drive space

2.0 Installing the Query System
2.1 Installing the EIA-176 Query System

To install the EIA-176 Query System on your PC:

1)
2)

3)
4)

5)

6)

7
8)

Download the software from the EIA web site.

Open Windows Explorer and find the file. The name will depend on which version was
selected. All executables will begin with EIA176Qry. The rest of the name will indicate
the version of Access that was selected.

Double click on the file EIA176Qry....exe and follow the instructions.

As the installation begins, a ‘Welcome’ screen is displayed. Click the ‘Next’ button to
continue.

The ‘Select Destination Directory’ screen will be displayed. Click the ‘Next’ button if you
wish to continue the installation to the default directory — C:\Program Files\EIA176Qry. If
you wish to change the default directory, click the ‘Browse’ button.

The ‘Ready to Install’ screen will be displayed. To continue with the installation click on
the ‘Next’ button.

A progress bar will appear.

When the installation is completed the ‘Installation Completed’ screen will be displayed.

Note: In some instances you will be prompted to re-start you computer to complete the
installation. This is normal and can be done immediately to use the query system, or later if
so desired.

2.2 Starting the EIA-176 Query System

The query installation program creates a program group and a desktop icon for the EIA-176
Query System. The desktop icon starts the query system up immediately and appears on the
desktop after the install program runs.

2.3 Compressing the File for best performance

The program group, which is available through the START menu has the EIA-176 Query System
icon, as well as an option to Optimize (Compact and Repair) the query system.
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Cammon Collection and Processing Systern [CCAPS]  #
Corel VENTLURA 8 4

ElA LAN Applications

EI&-176 Query Spstem » T BB M5DOS Frompt
ExTRaA! for Windows 4 I“_:;] Outlook Erpress
Mew Office Document .
—: G ator L @ SideStep

E Open Office Document lomega b | [2) Windows Explorer
Microzaft Hardware »
@ — Microsoft Office Pro 95 b
Microzoft Feference 3
Proaramsz 4 _
— Microsoft SOL Server 7.0 3

! Microsaft Netteeting
25 Microsoft Outlook
L Microzaoft PowerPoint
El%-176 Query System
ﬁo Dptimize D atabaze

The Optimize option should be run periodically so that the query database does not become
fragmented. In the Access 2000 version the compact and repair option is available from the File

Menu.
Fzl EIA-176 Query System

I File Edit Datasheet Exit

= Cloze Window,/Fepart
Save bz

Expart...

Compact and Repair Databaze...

% Erirt. ..

£

ia)
|

In the Access 97 version it is only available from the Program Group, as shown above.
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3.0 Using the Query System

After a successful installation you can use the query system to print off individual company
submissions or to generate data files from your Windows desktop by clicking the START button,
then the Programs button. Select the EIA Applications items, and then click EIA-176 Query, and
the Main Menu Screen of the query system is displayed, as show below:

3.1 Main Menu

=lol=

Energy Information Administration

he most current ElA-176 Query System

ears data are:

|2002

1997
1998
1999 Query EIA-176 Data
2000 —I

atafor [2001
re also available

View EIA-176 Respondents

| Exit
it the ElA Natural Gas web site at:

viela.doe.govioll gas/natural gas/data publications/nat data publications.himl

¢ the new Natural Gas Navigator at:

aitonto eia.doe govidnawng/ng sum top.asp

The three main options available in the EIA-176 Query system are accessed via this
menu. They are:

1) View EIA-176 Respondents: Click this to choose individual respondents and view
or print their submissions

2) Query EIA-176 Data: Click this to choose pre-selected or user selected queries
which will allow the user to save data to PC-compatible files

3) Exit: This ends the EIA-176 query.

Each option is described in the sections that follow.
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3.2 View EIA-176 Respondent
3.2.1 Select a Company

After clicking the View EIA-176 Respondents button on the Main Menu, the following Choose
EIA-176 Company Screen is displayed.

1) Select the report year first.

2) Select the retrieval method

B3 ¥iew EIA-176 Respondents - Choose Company(s) -1al =]

View EIA-176 Respondents - Choose EIA-176 Company(s)

1997

You can Please enter a report year: 1993

select one Choose a retrieval method 1999

or more 2000
companies #  gelecta Company in a State
by name 2002
or state . #  Selecta Company by Name

Use the
arrow
buttons to
selecta
state or Print
company. Selections

Yiew ==

If you select a company by name you will see a list of EIA-176 company names. If you select a
company in a state you will get a list of states. The companies will appear after you select a state.

3.2.1.1 Select a Company in a State

If you Select a Company in a State you'll see a list of states

located in-

Highlight the state(s) you want and use the single right pointing arrow
between the two white boxes to move the state to the selected box.

To unselect a state use highlight it in the selected (leftmost) box and use the single left

L 1
pointing arrow J to move the state out of the selected box.

Once you've selected a state click on the Select Company button to see available companies

Select

within that state. CLAnEELY)

Use the mouse to select the company you want to view in the Companies available box. Click the
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right pointing arrow to move it to the selected box on the right.

3.2.1.2 Select a Company by Name

B2 ¥iew EIA-176 Respondents - Choose Company(s) 10l =]

View EIA-176 Respondents - Choose EIA-176 Company(s)

. 1997
You can Please enter areport year: 1990
selectone Choose a retrieval method 1999
or more 2000
i [0 : 2001
companies Select a Company in a State SO0
by name <UL
or state . ' Select a Company by Name

Select Respondent Name

Companies Available Companies Selected
AZ | ADJUSTMENT PIPELINE ﬂ EL PASO NAT GAS GO AT
A7 BEMSON CITY OF 659'“‘
Use the AZ  BLACK MOUNTAIN GAS G Y
arrow A7 | CITIZENS COMMUNICATIO!
buttons t AZ | CITIZENS COMMUNICATIO! # | View =>
Utonsto a7 EL PASO NAT GAS CO =
selecta A7 GILA RESOURCES -
state or AZ | GRAHAM COUNTY UTILITIE - | Print
company. AL MESA CITY OF Selections
A7 |MOJAVE PIPELINE COMP:
AT NAVAJO TRIBAL UTIL AUTH
A7 |SOUTHWEST GAS COR = <=Back
] | | » ] | | _>|
El Paso Natural Gas has been selected.
3.3.2 View and Print EIA-176 Respondent Submission
View =>
To view the submissions click the View=> button.
Print
Selections

To print the submission without previewing it click the Print Selection button.
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iew EIA-176 Company

o yrwgeea, doe.goy
em |Energy Information
Administration

FORM EIA-176
REPORT YEAR 2002

Foarm 2pproved
OMB Mo, 19030175
Expiration Drate: 117300

ANNUAL REPORT OF NATURAL AND SUPPLEMENTAL GAS SUPPLY AND DISPOSITION

confidentialitya finfmmation and mandtions statements, sz instructions.

its purisdiction

Thiz report is mandatory underthe Federal Energy Administration Act of 197 4 (Public Law 93-274), Forthe prowisions conc: ming the

Tide 18 USC makes it a criminal offense for any person knowingly and willingly to make to any Agency
or Department ofthe United States any false, fictitious, or fraudulent statements as to any matter within

SECTIOHN I. RESPOHDENT IDEHTIFICATION

Ertar e nams and malling addre in o 41e company fllng 11s EL-178
EIA ID Humber 176035564

Company Name: EL PASC NAT GAS CO
Opergtionz in (S@te): Opzin ARIZON A

Address 1

Address?:

City

View Respondent result — Preview screen

Cornplete and retum by March 1, 2003 to
Erergy Information Sdmini stration:

L5, Department of Erengy
P.0 Box 8279
Silwer Print, MD 20907
BTTH: Forrn EIA-1TE

OR
Faxto: [202] 326-1076

Ernail to: 000G SURMEY Sieiz.doe gow

You can maximize the preview screen by clicking on the resize button in the upper right corner.

| MEE

You can view subsequent pages of the preview screen by clicking the navigation buttons at the

bottom of the screen.

IPage: oLl 7 bl (&

The right pointing arrow > takes you to later pages.

The right arrow with the bar >| takes you to the last page.
The left pointing arrow < takes you to earlier pages.

The left arrow with the bar |< takes you to the first page.
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3.2.2.1 View EIA-176 Company Menu

The View EIA-176 Company Menu lets you control this display.
E: EIA-176 Query System

“ Exit O Page Setup... JO Sherint... £ Close

‘ Ext — Closes this application.
B Page Seu'”'_ — Allow you to choose a printer and set the page orientation (portrait works best).
e — Changes the magnification of the report.
Senit... — Sends the report to the printer.
i Close

_ — Closes this report and either shows the next report if you've selected more than
one, or returns you to the Choose Company screen.

Once you've returned to the Choose Company Menu you can exit this function by clicking on the
<=Return button.

<=Return |

This will return you to the Main Menu.
3.2.2.2 Choose Company Arrow Functions

Below is a summary of what the arrow buttons in the Choose an EIA-176 Company

do:
Moves the highlighted item in the left box to the right box.
Move all the items in the left box to the right box.

M

o Moves the highlighted item in the right box to the left box.
1 Move all the items (highlighted or not) from the right box to

— the left box.
L
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3.3 Query EIA-176 Data
To view, select the Query Menu from the Main Menu.
There are two query options: Pre-selected, and User-selected.

B Query EIA-176 Data - Query Menu

Query EIA-176 Data

Preselected Query Menu
queries
create files
with
redetermined )
pE| A176 items Pre-selected Queries

] (see notes for available years)

Custom
queries create
files with EIA- _l Custom Queries
176 items that

are selected
from a list

_l Back

The Pre-selected Queries option offers 24 queries that can be run on all or selected companies.
The queries and the data items they include are detailed in Appendix B.

The User-selected Queries option allows users to select other EIA-176 data items for inclusion
in data fields. They have a structured format. The rows will always be EIA-176 companies; users may
select column data values.

The following sections will describe these two options.

3.3.1 Pre-Selected Queries

Pre-selected queries are queries whose conditions have already been created. These queries save
the user the trouble of having to set the desired conditions each time he/she wishes to run the pre-set query.

The following pre-set queries are available:
Sorted by:
State
Volumes by sector (sales + transported)
Prices by sector
Rankings, by volume, national, and within States
Type of Operations

Other:
Detailed data on continuation lines.

The first step in the pre-selected queries is to choose the year and company(s) you want to query.
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3.3.1.1 Select a Company Screen

The Select Company screen for the queries is quite similar to that described in the View Respondent option
which is described in section 3.3.1.

Begin by selecting a year in the ‘Please enter a report year:” .

You can select EIA-176 companies to include in your queries. If you want all companies choose the Select All
Companies option, this retrieval method does not appear on the View Respondents menu. This will close this

screen and go to the select queries screen.

The same white boxes that were used in the view respondent data are used here. If you Select a Company in a
State you'll see a list of states to choose from.

Once you've made your selections click the Next=> button to select a query to run.

Next => |

B3 EIA-176 Pre-selected Queries I ] JE5

Select a Query to Run 2002

Selected Years:

Pre-selected Queries Query Description
This Query has all Part v & % YVolume
All Part %1 lterns (Wolumes, Costs) iterns.
2K ~| || Al Sectar ltems (Wolumes, Costs, Cansumers)
::; All Sector items sorted by state
a7 Sector Sector Prices
CA Residential Sector walumes - Delivered, Transported, Tatal
oh Commercial Sector Yolumes
o Marme and Address Information
cT Industrial Sector Wolurmes
e Dietail level Cantinuation Lines
DE ll Footnotes and Agsociated Data Values
Sectar Yols sorted by sector
Flartric Qartar valimes =l
<=Back Run Query ==

A detailed description of each pre-selected query can be obtained by highlighting the query title. The description
appears in the box titled Query Description.

Once you've selected a query by highlighting it, click the Run Query=> button to execute the query.

Run Guery =>

The status bar is displayed at the bottom of the screen while the query is running. Some queries take a few
moments to be displayed.
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The blue bars
show query
progress.

Funning query |mm

I B ElA-176 Pre-selected Queries

i Qry_AllCon_1 : Select Query

|| CompanylD COMPANYNAME ST ResVol ResCost |ResConsumery CommVol
L g BARROW UTIL & ELEC COOP INC AK 221,971 514 ,510.0 1,132 387,87
| |17602009AK  UKPEAGVIK ARCTIC SLOPE AR 0 0.0 0 1,465 7¢
| |17602016AK  ALASKAP L CO AR 0 0.0 0
| |17602017AK | ENSTAR NAT GAS CO AR 15,756,589 | 56,585,957.0 a0,117 6,698,4(
| |176133004K  |\MARATHON OIL CO AR 0 0.0 0
| |17617544AK  CHEVRON USA PROD INC AR 0 0.0 0
| |17617545AK  UNION OIL CO OF CALIFORMNIA — AK 0 0.0 0

| |17619863AK  PHILLIPS ALASKA NAT GAS CO AK 0 0.0 0

| |17622751AK  ARCO ALASKA INC AR 0 0.0 0 7,009, 2¢
| |17600048AL  FLORALA GAS DEPT AL 21,680 133,170.0 542 2
| |17600049AL  WEST JEFFERSON GAS SYS AL 25 653 24890930 520 30
| |17600139AL  ALABAMA GAS CORP AL 27627365 258,719,083.0 430,069 9,747,2(
| |17600141AL  MIDCOAST INTERSTATE TRANS IMAL 0 0.0 0

rewsi ] T e ema oy ey PRP— P Pp—

LT T e LSy T T T T T |

<=Return Run Query =>

Query output is displayed in a grid on your screen.
3.3.1.3 EIA-176 Query Menu Functions

Menu items at the top of the screen are used to filter output, or export to other data formats.

2, Microsoft Access

“ File Edit Datasheet Tools Exit

File
J| File Edit Catasheet Tools Exi

i ﬂ T p— | Close — Closes the query grid. .
= : Save As/Export —Saves the data to another file
Save As{Export Datafile Page Setup — lets you choose print settings
L Page Setup. .. Print Preview — Shows what a printout will look like
[&, Print Preview Exit — Quits the Query system.
Clase Spreadshest
&P Print...
Exit

Close — Exits the select query window.
Save As/Export - option opens an intermediate box.
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-
CompanylD COMPANYNAME ST ResVol ResCost ResConsumery] Com
» [176020034K  BARROWY UTIL & ELEC COOP INC AK 221,971 514,510.0 1,132 :
_|178020094K  UKPEAGVIK ARCTIC SLOPE AK 0 00 0 14
[ |178020168K  ALASKAPLCO EAOYYS 00 0
17502017AK  ENSTAR NAT GAS C 5,987 0 90,117 6.€
T |176133008K  MARSTHON OIL o | ~ove Query Qry-Allcen t 0.0 0
17617544AK | CHEVRON UsA PRQL| ©iTa.2nBxermal File or Database P— 0.0 0
__|178175454K  UNION OIL CO OF C — : [ cnel | 00 0
| |175198634AK  PHILLIPS ALASKA M 00 0
[ |178227518K  |ARCO ALASKA INC e irre? [any_alicont 0.0 0 70
_|178000485L  FLORALA GAS DEP” 31700 542
__|176000494L  WEST JEFFERSON 18,993 0 520
[ |17600139AL  ALABAMA GAS CORP AT B2 365 758,719,088 0 430,069 9.

17600141AL  MIDCOAST INTERSTATE TRANS IMNAL 0 0.0 0

P | R 111 - Y I D 0
After you choose this option you will be presented with an initial ‘Save As’ dialog box. Select the
‘To an External File or Database’ option, and click the OK button. You will not be able to access
your file if you choose the ‘Within the Current Database’ option.

Next you will be presented with a Windows dialog box. Headers may look better when you select
Save Formatted.
You can put your own name into the File Name box.

=t Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol ResCost ResConsumers
L 176020034k, BARROWY UTIL & ELEC COOP NG | Ak 221 971 514 5100 1,132
AR =PV S ave Query "Qy_AlICon_1" In... HE
17602016AK  ALL .
| [17em20t7aK Ewg SR |1 Exportedries = =
- 176133004k h14, MewGasact, x|s ENewGasActhls Eer_CnnPrice_ﬁ.xls ﬁUQrvPS Expork I
| 17617544 AK CHE MewGasactE, xls ﬁNewGasActJ.xls ﬁer_CnnRank_&xls
| |17B17545AK0  (LMI MewGasickC, xls ﬁNewGas.ﬂ.ctK.xls ﬁer_CnnRankST_S.xls LEBII
176198634K. PHI MNewGasackD, xls ﬁNewGas.ﬂ.ctL.xls ﬁer_ConSrtSec_&xls
N 1FE22751A AR MewGasackE., xls ﬁNewGasActM.xls Eer_Cnntinuations.xls
| |176500043AL FLC MewGasActF, xls ﬁNewGasActN.xls ﬁer_nma_‘B.xls fatted -
| 1760004941 WE MewGashcka, xls ﬁNewGasActO.xls ﬁer_Prod_CstB.xls Text files may
[ [17600139AL AL ? INewGashct s Gry_ConCT_4.xls “F']UerP4Lx|.QLL.x|s Autostart zi‘égen;;ﬁly by
| [17800141AL MIC ave checking the
| |17600162AL  ALE & 4l Save
| |17B00B18AL  ATH £ Selection Eormatted box.
F——— - ou save
Record: 14| « || Excel files with
File narme: IQrv_P.IICon_l s ;I this option the

headers look
nice when you
open the file in

Save as bype:

Mat all file types are installed by default. To add other file tvpes, rn the Setup program, click AddfRemove, Dat
Access, Change Option. Additional file types are also available infhe Cffice 97 YaluPack,

/
Different file type options are available by pulling down the/Save as File Type'’ list box as shown.
By scrolling down the list of available file types you can choose dBase formats also.

Once you've named your file and selected the file type to save as click the Export button to finish

the operation.

Page Setup
This option lets you set print settings and page orientation.
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8 EIA-176 Pre-selected Queries

[7]x] =
| sCost ResConsumers

1,132
a0
a0

a0, 117

Lo o i an )

a0

542

520
430,068
a0

Page Setup
CompanylD COMPANYN ™ Fiargine 1 Page
¥ [17602003AK  BARROW UTIL & ELE 14.510.0
" [17602000AK  UKPEAGVIK ARCTIC | [-Margins (inches) 00
_[17602016AK  ALASKA P L CO op [ 00
176020174K  ENSTAR NAT GAS C( 85.087 0
_[17613300AK  MARATHON OIL CO Bottom;: [1” 00
176175448K  CHEVRON USA PROL 00
" [17617545AK  UNION OIL CO OF C£ | ef 1 00
176198638K  PHILLIPS ALASKA N, 00
— Right: 1"
_[17622751AK  ARCO ALASKA INC o | 00
" [17600048AL  FLORALA GAS DEPT 33.170.0
" [17600049AL  WEST JEFFERSON (| & print Headings 48,993 0
_[17600130AL | ALABAMA GAS CORF 19,088.0
" [17600141AL  MIDCOAST INTERST, 00
Record: 14| <] T o mDof 17927 —m“
<=Return [

o]

Cancel |

Most query output looks best with the print orientation Landscape. This can be selected from the
Page tab.

EIA-176 Query System
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Print Preview

i Qry_AllCon_1 : Select Query

| Page: |4|<| 1 p|>||
The Print Preview buttons lets you see what the printout will look like.
Print

The Print button prints the grid off. Some of the queries may be large.

! Ory_AllCon_1 : Select Query

CompanylD COMPANYMNAME ST ResVol Res

L 1760200348K  BARROW UTIL & ELEC COOP INC AK 221,971 5
|| 17602009AK  UKPEAGVIK ARCTIC SLOPE AR ]
| [ 17602018AK  ALASKAPRP L CO Al i
| [ 17602017AK  ENSTAR NAT GAS CO _I 56 5t
| [ 17613300AK  MARATHON OIL CO  Mow printing page 3 of
| [ 17617544AK  CHEVROM USA PROD INC ‘Qry_alicon_1' o the
| [ 17617545AK  UNION OIL CO OF CALIFOI
| [ 17619863AK  PHILLIPS ALASKA NAT GA EPSON Stylus Photo on LPT1:
| [ 176227T51AK  ARCO ALASKA INC
| |17600048AL FLORALA GAS DEPT 1:
| |17600049AL  WWEST JEFFERSOM GAS SYS AL 25 B53 2
| [ 17600139AL  ALABAMA GAS CORP AL 27 B2T.365 0 2587

176001414 MIDCOAST INTERSTATE TRANS I AL ]
Recar‘d"mr‘_“‘.p.pﬂ of 1782 <| |
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To use the Copy option the grid or column needs to be highlighted. The entire grid can be
highlighted by clicking in the upper left corner (circled). Individual columns can be highlighted by
clicking in the column header.

To use Find, select just one column by clicking on the column header. The ST column is
highlighted in this example.

JFiIe Edit Datasheet Tools Exit

|82 - ‘CDpy Chrl+C BEY o a®(slil R A X BAa-

#, Find MNext
e, |
CompanylD COMPANYNAME ResVol Res
| 17602003AK | BARROWY UTIL & ELEC COOPF [NC 221,971 G
|| 17602009AK UKPEAGYIK ARCTIC SLOPE 1]
|| 176020184AK  ALAESKAP L CO 0
17602017AK  ENSTAR MNAT GAS CO 15,756 589 56,5

176133004K  MARATHOM OIL CO 0
176175444 CHEVRON USA PROD INC 0
176175454K  UNION OIL CO OF CALIFORNIA 0
17619863AK  PHILLIPS ALASKA NAT GAS CO 0
17622751AK ARCO ALASKA INC 0
1760004840 |FLORALA GAS DEPT 21,680 1

With the column selected puII down the Edit menu and click on the Find option.

& Qry_AllCon_1 : Select Query

P e

CompanylD COMPANYNAME ST ResVol ResCost F
|| 17618300IN OHIO WALLEY GAS INC M 440,343 2,850,052.0
|| 17619004 1N REMSSELAER GAS UTIL DEPT T4} 246,026 1,381,073.0
|| 176190191N POSEYVILLE MUN GAS CO M 29,650 252 386.0
|| 176190241N WESTFIELD GAS CORP IT4) 103,846 867,427.0
|| 17619633IN TEXAS EASTERN TRANS CORP M 1] 0.0
|| 17619807IN SWITZERLAND CTY MAT GAS CQ |IN 49,851 378,354.0
|| 17619692IN BAINBRIDGE MUN GAS M 25,260 203,585.0
|| 17619912IN NAFPOLEON TOWYN OF [T+ 13,684 96,340.0
|| 17619913IN COMMUNITY MAT GAS CO INC M 481,939 3,571,058.0
|| 17630608IN MNAT GAS P L CO OF AMERICA, [T+ 0 0.0
|| 176841051N SIGZORE ENERGY SERVICES I+ 0 0.0
|| 17684713IN VECTOR FPIPELINE I 0 0.0

P [17600032KS  ABBYVILLE CITY OF ﬁ 4,515 25,3950
| Recortt W11~ 5 vl
Cunsumptlnn /ol B
P = e R 1 IKS
<=Ret Search: IAII 'I I™ Match Case Eind Mext |
" Search Fields 4s Farmatted
— Mauh Il”'\JIhDIE Field j ¥ Search Cnly Current Field Close |

A dialog box will appear. Enter the value you wish to search for. After you've centered the value
you want to find click either Find First, or Find Next. The grid will advance to the found value or tell
you that no values exist.
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Datasheet
Datashest Tools Exit Font - adjusts the type in the grid
i A Font. Freeze columns -makes the frozen column

always appear

Sort Ascending/Descending - sorts the data in
the grid by the selected column

Advanced Filter - lets you enter some simple
criteria for data in the query.

Apply Filter - is used in conjunction with
Advanced Filter

Remove Filter/Sort — removed the Applied
Filter

§ [0 Freeze Columns

" 2] cort Ascending

I'2] Sort Descending
W advanced Filter/Sort...
W apply FilterjSort
B Remove Filter/Sort

I ERGEELEEI [WTTS

Datasheet items allow you to manipulate the query that you've run.

Click in the
circle to
highlight the
entire grid.

The Font menu item changes the font of the data in the grid.

7
COMPA ™ = t
3 VALLEY G, E Fant style: 520
ISSELAER G. |Regular oK | 73.0

EYWVILLE ML 6.0
- . | arial Black =1 [malic Cancel
STRIELD GA F Arial Marrow Bold -| 4| 7.0
AS EASTERDN |E BakerSignet Bald Italic 0.0
ITZERLAND € Ege::goﬂc Black 4.0
ellGothic Blad
NBRIDGE ML B Bernhard Modern Romzx] 5.0
'COLEDM TOW w00
AWAUNITY MNA —Effacts 59.0
GASPLCC 0.0
—CORE ENERI _ AaBbYy7z 0.0
cerl

“TOR PIPELI | - 2eerine 0.0
YVILLE CITY i;°'°“ - 350
E— [ [N - Script: —
» |>| |He| of 17 |'u'\-'estern LI

nption Vals for

[N SR U J P

This is a TrueType font. This same font will be used on both
your printer and your screen.

<=Return

In this example, selecting Bold turns all the items bold.
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l e&f Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol

| |17618300IN OHIO VALLEY GAS INC IN 440,343
| |17618004IN RENSSELAER GAS UTIL DEPT IN 246,026
| |17618018IN POSEYVYILLE MUN GAS CO IN 29,650
| |17618024IN WESTFIELD GAS CORP IN 103,846
| |17618633IN TEXAS EASTERN TRANS CORP IN 0
| |17618807IN SWITZERLAND CTY NAT GAS COIN 49,851
| |17619892IN BAINBRIDGE MUN GAS IN 25,260
] L 17619912IN NAPOLEON TOWN OF IN| 13,684
| |17618913IN COMMUNITY NAT GAS COINC  IN 481,939
| |17680608IN NAT GAS P L CO OF AMERICA IN 0
| |17694105IN SIGCORE ENERGY SERVICES IN 0
| |17694713IN VECTOR PIPELINE IN 0
| |17600032KS  ABBYVILLE CITY OF KS 4515
Record: 14 4] 513 e el of 1792 T Al 1 '-“

The Freeze column options lets you always display one column on the screen.
To freeze columns place your cursor in the column you wish to always view. In this example that column is
COMPANYNAME.

/

COMPANYMNAME ST CompanylD ResVol ResCost R
’_BA ROW LITIL & ELEC COJP INC [ AK 176020034K 221,971 214.510.0
|| UKPRQGYIK ARCTIC SLO Al 176020094K 0 0.0
| |ALASKA Al 176020164K 0 0.0
| |ENSTAR NAT GAS CO Al 17802017 AK 15,756,589 56,585 967.0
| |MARATHOMN OIL CO A 1TE133008K 0 0.0
| |CHEVRON USA PROD INC A 176175442 0 0.0
| |UNION OIL CO OF CALIFORMNIA A 176175458 0 0.0
| |FHILLIPS ALASKA NAT GAS CO |AK 176198634 0 0.0
| |ARCO ALASKA INC A 17B227518K 0 0.0
| |[FLORALA GAS DEPT AL 1760004841 21,880 133.170.0
| |WEST JEFFERSON GAS 5Y5 AL 1760004341 25,653 2459930
| |ALABAMA GAS CORP AL 1760013341 27,627,365 258 719,088.0
| |MIDCOAST INTERSTATE TRANS INAL 1760014 1AL 0 0.0
Record: 1| ][ 1 »{m[iifaf 1792 < — T
Pull down on the Datasheet menu item and click Freeze columns.
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Es EIA-176 Query System
“ File Edit | Datashest Tools Exit

“g - FA Eont. ..

1| Freeze Columns
%l Sort Ascending
| El Sort Descending
T advanced Filker[Sort...
M Zs apply Filker/Sort
% B Remove FilkerjSart

The COMPANYNAME column always

appears at the left. Even when scrolling to the
right, COMPANYNAME stays on the screen:

& Qry_AllCon_1 : Select Query

- COMPANYMNAME ComCost |ComConsumer| Othe
fLBARROW UTIL & ELEC COOP INC 756 030 215
| |UKPEAGYIK ARCTIC SLOPE 507 003 3
| |ALASKAF L CO 0 0
| |EMNSTAR NAT GAS CO 21445 075 12,420
| |MARATHOMN OIL CO 0 0
| |CHEVROM USA PROD INC 0 0
| |UNION OIL CO OF CALIFORNIA, 0 0
| |PHILLIFS ALASKA NAT GAS CO 0 0
| |ARCO ALASKA INC 9,296 911 25
| |FLORALA GAS DEFT 1,305 4
| |WWEST JEFFERSON GAS SYS 25,366 22
| |ALABAMA GAS CORP 78,594 955 33,822
| | MIDCOAST INTERSTATE TRANS M 0 0

Record: 1l || 1 v w[e] of 1792 i S |

Columns can be ‘unfrozen’ only by exiting the query grid.

EIA-176 Query System

1/26/04 -

20 of 38



EIA-176 Query System User’s Guide 1/26/04)

| Datasheet Tools Exit
| o || & & 8] &l % v v |88 b x|
i Feee covms. o i

i %lJ Sort
_El Sort Descending
T advanced Filter/Saort. ., COMPANYNAME :
¥._ apply FiterfSort ROWY UTIL & ELEC COOP INC AK :
W, Rernove Filter/Sort EAGYIK ARCTIC SLOPE A
|| 17602016AK  ALASKAP L CO Al
|| 17B02017AK ENSTAR NAT GAS CO A 56 %
|| 17613300AK MARATHON OIL CO Al
|| 17B17s44AK  CHEVRON USA PROD INC Al
|| 17E17e45AK UNION OIL CO OF CALIFORNIA A
|| 17619863AK PHILLIPS ALASKA NAT GAS CO 4
|| 1TE22T51AK ARCOD ALASKA INC A
|| 1760004841 FLORALA GAS DEFT AL
|| 176000494 WWEST JEFFERSON GAS 5YS AL z
|| 17600130AL  ALABAMA GAS CORF AL 2587
|| 17600141AL MIDCOAST INTERSTATE JRANS 1M AL
Recard e[ < [[~ 1 »imljefizez =/~ |

To use the sort z'iécending feature select a column by clicking on the column heaciing. Pull down the Datasheet
menu and click on Sort Ascending. The query will be sorted according to the values in the selected column.

& Qry_AllCon_1 : Select Query

CompanylD COMPANYMNAME ST ResVol
P 117680806TH.  PANENERGY TEXAS INTRASTATE TX i
17694747M0D ALLIANCE PIPELINE MO 0
17692405FL SOUTHERM MAT GAS CO FL 0
1769232711 SOUTHWEST GAS STORAGE CO L 0
17692326MI SOUTHWEST GAS STORAGE CO - M| 0
17690603M0 KN INTERSTATE GAS TRAMNSLLC MO 0
17690514CA  CPMN PIPELINE COMPANY A, 0
17690506Ms  DESTIN PIPELIME CO LLC hS 0
17692726MM  PINNACLE NATURAL GAS CO Pyl 0
17681218AR  OZARRK GAS TRANS LLC 1AR 0
176927240 SEMCO ENMERGY FIPELINE il 0
176806197 LOWWER COLORADD RIVER ALITHC TX 0
17680617LA JEFFERSORN ISLAMD STRGE & HU LA 0
Record: 14l <10 1 wimbslof17ez <~ | .

In the example above the ResVol values are sorted in ascending order, starting with zero.

Sort descending works the same way.
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g=f Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol

’_ 17621931CA SOUTHERM CALIFORNIA GAS CO CA ; 0
L 1781032210 MICOR GAS IL 221 009 522
_1TB10817CA PACIFIC GAS & ELEC CO CA 211,181,852
L 17B1T183MI CONSUMERS EMERGY CO Il 176,663,600
L |17609432MI MICHIGAN CONSOL GAS CO Il 136,124,328
L |17611456NJ  PUB SVC ELEC & GAS CO MJ 132,611,115
_|17EF03170H  EAST ORHIO GAS CO OH 131,187,521
. |17610860I1L PECOPLES GAS LT & COKE CO 103,856,141
. |[17601565NY  KEYSPAN ENERGY DEL CO 88,463,564
L |176114508C0  PUB SYC CO OF COLORADO 86,738,308
L |176162350H COLUMEILA GAS DIST CO 78,312,118
L 17B17436TA TAU GAS DISTRIBUTION 75,700,397

L |17622738MN RELIANT ENERGY MINNEG cO MN 68 957 847

With sort descending the largest values appear first.
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Datashest Toolk Exit
] A Font...

§ [ Freeze Columis
" &) sort Ascending

o A® HE TEY A K Ba-

2} Sort Descending
T COMPANYNAME ResVol ResCost |ResConsumery§ CommVol

Ay FiItEn"Sclr RROWY UTIL & ELEC COOF INC AK 221,971 5145100 1132 387,816
K Remove Fiter/Sort PEAGYIK ARCTIC SLOPE AR 0 0o 0 1465764
| [17802016AK  ALASKAP L CO AR 0 0o 0 0
| [17802017AK ENSTAR NAT GAS CO AR 15,756,588 56,585,987 .0 0,117 5,698,403
| |17613300AK  MARATHON OIL CO AR 0 0o 0 0
| [17617544AK  CHEWVRON USA PROD INC AR 0 0o 0 0
| [178175454K  UMICON OIL CO OF CALIFORMIA  AK 0 0o 0 0
| |17619863AK  PHILLIPS ALASKA NAT GAS CO - AK 0 0o 0 0
| |17622751AK  ARCO ALASKA INC AR 0 0o 0 7,099,290
| |17600048AL  FLORALA GAS DEPT AL 21,680 133,170.0 542 212
| [178000494L WEST JEFFERSON GAS 5Y5 AL 25,653 2489930 520 3,779
| |17600139AL  ALABAMA GAS CORP AL 27,627,365 258,718,088.0 430,069 9,747,205
| 1760014140 MIDCOAST INTERSTATE TRANS INAL 0 0o 0 0
T I T T L R T | = = =

To use the Advanced filter option no rows need to be selected. Just pull down the Datasheet menu and click on
the Advanced filter option.

The filter design window will appear.

g=! Qry_AlICon_1Filter1 : Filter This window can be resized by
r——— — stretching the edges.
Qry_AllCon_1

*

1) The first step is to copy the field
you want to search from the field
list into the criteria grid.

CampanyID
COMPAMYRARM
=1)

«
RYal ;I

an either drag the name of
the column you want to search or
sort by in the upper pane of the

< |

— window into the criteria grid in the
Field: [] = lower pane of the window, or
Sart: double click on a field to copy it to
Criteria: the next available field cell in the
Elk: grid.

4 |

" Qry_AllCon_1 : Select Query

__ | CompanylD COMPANYNAME ST ResVol HR| CommVvol |C|Cor OtherNugsvol
'? il CALERA CITY OF AL 57,665 12 20917 510 1,688
__|17818578AZ  SOUTHWEST GAS CORP A7 26,146 540 14 20,419,530 3 29 3,832 109
__|17608584CA  LONG BEACH CITY OF CA, 6,183.814 16 2,103,884 4 111 313,244
__|17B106817CA  PACIFIC GAS & ELEC CO CA 211,181,852 149 58 646 965 3 48 660,902
__|17B10644CA | PALO ALTO CITY OF CA, 1,366,627 13 1,363,762 7 56 24 941
__|17B802792CT | YANKEE GAS SVC CO CT 13,298 447 10 7,237 B66 |3 150 241 615
__|17612046FL | INDIANTOWN GAS CO FL 17,799 01 11,2191 29 683,174
_|17613084GA  HOGANSVILLE CITY OF GA, 69,909 13 14,157 10 15 20186
_ 1760816414 LAMONI MUN UTIL |4, 62,140 10 26421 7 06 1,961
1761904914 ROLFE MUN GAS SYS &, 30,306 19 9,553 3 M 4,492
__|17608308IL ILLINCIS PWR CO IL 34211108 14,213,005 5 328 1,964,110
_|17621018KY  RICHARDSVILLE GAS CO WY 3567518 60493 7 2555

1761655804 BAY STATE GAS CO Ml 23,083,858 14 £,339,596 7 104 137,634

Record: 14 ]| T O DA of 37 (Fitered) <] - |

[l
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gzt Qry_AlCon_1Filter1 : Filter

Qry_AlCon_1

*

CompanyID
COMPAMYMAR
aT

Rial :j

<« |

Field: -

2) By clicking on the Field column in the lower pane
you can get a list of fields in the query.

Sort: |[ Qe AllCon_1.* -]
Criteria: || CormpanylD 'l
or: || COMPANTYMAME —
ST
Rial
RCost
R Corzurmners
Cvol
4 |
3) In this example :
: Field:
Field: | Bal we've selected the Slzrt- Ri/ol
Sort: v RVol field Ciliafhr
| " _ L . rkeria: | >90000
aitena: (| Ascending You can pull down ar: 1

or: || Descending

[mat zorted) \

4 |

the sort cell and
specify a sort order
if you want.

4) In the Criteria cell
we've entered a
condition that Rvol
be greater than
900000.

Datasheet Tools Exik
| A FEE G e
| [ Freeze Ealimmns
: %l St Ascending
i El Stk Descending
W advanced Filker/Sort. .

Apply Filker/Sort

. Remove Filker fSort

5) Click on the
Apply/Filter Sort
toolbar button when
you're ready to apply
the filter. Any records
that don’t meet the
criteria you specified
will disappear from
the view. They have
been filtered out. If
you click on the
Remove Filter/Sort
button they will
appear again.
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COMPANYNAME | ST | ResVol
TMAT GAS CO A1 17,418 738
AA GAS CORP AL 26 272 23
/ILLE NAT GAS DEPT AL 1,791 406
=AST ALABAMA GAS DIST AL 1,729,012
CEAS SYC CORP AL 4042 543
IATED NAT GAS CO AR 1,232,041
SAS WESTERN GAS CO AR B 510,113
SAS OKLAHOMA GAS COF AR 2 570 524
TEMERGY ARKLA AR 25,186 915
SITY OF AZ 1,024 299
WEST GAS CORP AZ 24 913 455
S UTIL ARIZONA GAS DIV AZ 5 527 555
IEACH CITY OF A, B R33,055
» GAS & ELEC CO CA 234,195 449

6) The rows that appear should meet the criteria. A note: on full survey datasets it helps to have plenty of
memory available. If you run a filter and nothing changes you may not have enough memory to process.

If you have enough memory, you are not limited to one field or value. You can select several fields in the
criteria grid. The EIA-176 Query system offers standard operators

= Equals

> Greater than

< Less than

>= Greater than or equal to
<= Less than or equal to
<> Not

To specify AND/OR criteria place the operators in different rows of the criteria grid.

Field: [ST
Sort;
Criteria: | T and bl
ar;

To express AND criteria within a single field use the
AND operator

This filter asks for a State value of TX AND MI.

Field: [5T R ol

To express AND criteria between fields put each

Sart:

criteria on the same row of the criteria grid.

Criteria; [T
ar:

This statement asks for ST equal to TX and Rvol >
90000.

EIA-176 Query System
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- To express OR criteria within a single field use the
Field: [5T OR t
S ot operator.
Criteria: |"Te " Or "MI" .
- This statement asks for ST equal to TX OR Ml
To express OR criteria between multiple fields place
Field: [ST Fal the criteria on separate rows of the criteria grid.
Sort;
Criteria; ["Ti " This statement asks for ST equal to TX or Rvol >
ar: >30000 90000.
I
o |

EIA-176 Query System
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3.3.2 - Custom Queries
The Custom Queries option allows you to choose individual data items from the entire EIA-176 for
inclusion in datasets. The methods are similar to those used in the Pre-selected queries.

B EIA-176 Query Menu

Query Menu
Preselected
queries
create files
with
predetermined

EIA-176 items Pre-selected Queri

Custom

queries create Custom Queries

files with EIA- Select wour own data opkions. |

176 items that
are selected
from a list

Back

3.3.2.1 View EIA-176 Company Menu

First you will be prompted to select Companies and Year. This screen is similar to the Company
selection screen in other parts of the query.

B3 Query EIA-176 Data - Choose Company(s) - |E||5|
Query ElIA-176 Data - Choose ElIA-176 Company(s)
19497

You can Please enter a report year: 1998

select one Choose a retrieval method 1889

or more 2000
companies Select a Company in a State Select all Companies | oo |
by name

or state . Select a Company by Name i

Choose EIA-176 Companies to include in your query

Use the
arrow
buttons to Next=>
selecta
state or
company.

After you've selected companies and the year, you will go onto the Select Reported Data Items
button. You'll be presented with a list of EIA-176 form data lines to pick from
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3.3.2.2 Pick Reported Lines

E Microsoft Access

| Fie Edit Datasheet Ext
R A A A == Er

User-Selected Queries - for year(s): | 2002
Select Reported Data ltems

fou have Select data items Products Selected
selected all
companies |1 part/ LineNo/ Description
4 0110 | Gas Produced onsystem by = 4 0700 Total Supply
4 0120 | Synthetic natural gas produ
4 0210 | Underground Storage Withdr
4 0220 | Received from LNG
4 0230 Other Storage Withdrawals
4 0300  Transparted into rpt ST from:
4 0400  Receipts at City Gate Add ane to selected itams.
i =1 |4 0500 Other Receipts
:; 4 0600 Supplemental Gasous Fuels ;I
ar 4 0700 Total Supply .
cn § 0300 Inwentary of LNG Einished
M B 0900 Heat Content of consumer de
co 6 1010 Delto Residential Sales
cT 6 1020  Delto Commercial Sales
b B 1030  Delta Industrial sales
EE B 1040  Delto Electric Power Sales
o El_l 1050 Del fo Wehicle Fuel _’l—l o 5
‘T IThe survey form has changed for 2002. /
o Refer to the form, and crosswalk to the old format below.
= =l http:/'www.eia.doe.gov/oil_gas/natural_gas/applications/eial76query.html

Once all your selections have been made click Finished Selectinl

3.3.2.3 Select Quantities and Build Calculated ltems

Each line item
with data from
the form is
represented
with a short
description.
The Part and
Line Number is
also included.
The highlight
method is
similar to that in
the Company
screen.

The Select Quantities and build Calculated Items screen has three parts.
Aggregate functions

Select Company Available Quantities.

Calculated field.

EIA-176 Query System 1/26/04 -
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B User Selected Queries - Select Quantities and build Calculated Items ) [
Make your type of operations and quantity selections before Add a Calculated
==Back clicking Complete. Field > Complete=>
Aggregate functions Average ﬂ
agreg Count
Sum -
4 I I L3
Select a Type of Investor Owened distributor ﬂ
Operations municipally owned distributar
{default is All) Privately ovwned distributor
Co-op distributor ;l
Un-check available quantities to include or exclude quantites  Available Quantities Quantities to include =
in you custom query in Query Output
Line Hum of Hum
Part Humber Description VYol Cost Consum Btu Mcf  wol Costor Btu Mcf
[T [o700][Total Supply I e rC
[6 " [1010] [Del to Residential Sales | R 2 I I 2 —1>
Ili_|1l12ll [pel to Commercial Sales IY_ I‘f_ I‘."_ I_ I_ | 2l r r
|6 [1030] [Del to Industrial sales | 2 2 I I 2 C T2 W W
[6 " [1040][Del to Electric Power Sales | (2 R I I T R W
- i
1 o

Available Quantiges:/

For<€ach line item you select this portion of the screen will have a row.
The Available Quantities portion shows you what quantities are available for this item.
The Quantities to include portion allows you to include or exclude quantities.

For this example, if you aren’t interested in the Number of Consumers for deliveries to
Residential Sales, you would use the mouse to deselect that item, and it won't appear
in your query data file.
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Type Of Operations

You can select multiple Types of Operations if you choose.

If no selection is made, all types are included. If they are all included they are not identified.

Aggregate functions

Average
Court

4l
Sum

iy

Aggregate functions

The Aggregate functions provide summary statistics for all the companies selected. The

Aggregate functions, the Type of Operations, and the Add calculated
exclusive.

functions are mutually

E=1 User Selected Quernies - Select Quantities and build Calculated Items

==Back |

Make your type of operations and quantity selections before
clicking Complete.

=10

Add a Calculated

Field == Complete==

Average
Courit
SLm -

cro

Agygregate functions

Irwvestar Cwvned distributor
hunicipally cvwned distribotor
Privately owned distributar
Co-op distributar

Select a Type of
Operations
(default is All)

-

=l

In the following example the Aggregate function has been grouped by Delivered to Consumers

gzl Dynamic_Query - Select Query

5T Year SmDIResSalvl| SmDIResSalCs| SmDIBesSalN(
P 2000 17633864 B4256459 53524
| |AL 2000 42425740 IEFE2AGTE F70220
| |AR 2000 6244801 261571912 A54121
| |AS 2000 32940263 00731424 a02489
| |CA 2000 ohR457 4538 3737E97 351 93185830
| |CO 2000 111748319 EO1E23106 12R5032
| [T 2000 364174 404416526 442457
| |DC 2000 13182680 1147 36865 126714
| |DE 2000 pER2099 TR4B0714 115961
| |FL 2000 13685251 158EA 3956 BABEZT
| [GA 2000 29425592 269730510 aE7 480
| [HI 2000 523675 9933534 30703
|1 2000 71408355 435303533 Fag7a0

record: M| [T 1 v |wmi]r#|ef 51 1]
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“ File Edit Catasheet Tool

s

Save As/Export,.,
(1l Page Setup...
& Prink Prewview

Close
Datasheet Yiew
&P Frint. ..

Exit

B User Selected Queries - Select Quantities and build Calculated Items

clicking Complete.

‘ <=Back |

Make your type of operations and quantity selections before

The File menu provides your query output options.
Close — closes the query and returns you to the
selection screen.

When you return to the selection screen your

company, year and data item selections will still be
in place. Any aggregate functions will be cleared.

=10] =

Add a Calculated

Field =>
A

Complete=>

Average B
Cournt

Sum -
<I I L4

Aggregate functions

Select a Type of
Operations
(default is All)

Investor Owwned distributor ﬂ
Municipaly owened distributor
Privately ovened distributor

v 4

Co-ap distribwtor ;l
Un-check available quantities to include or exclude quantites
inyou custom query
Line
Part Humber Description
[ [0700 [Total Supply /
[6 " [1010 [Del to Residential Sales /
IB_|1l]2ll |I]e| to Commercial Sales /
[6 " [1030 [Del to Industrial sales /
|6 [1040 [Del to Electric Power Sales /
1| /

Quantities to include =
in Query Output

ailahle Quantities

A N Em s o
A
e
add 3 mm g u e
N
CH RN

e

To Add a Calculated Field make yOIAuantity selections first, and don’t select an Aggregate function. Then
click on the Add a Calculated Field button. This opens another window.
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5 Uzer Specified Calculations Choose variables from this list.

ElA-1TE Query System - User D

Available EMAT6 variables [|DIResSalval] «|
[DIResSalCst] e Your expre

appear here.

|DIResSalCon]
Click on variables to add o | [D1C0mSalol]
the expression [DIComSaiCst]
[BIComSalCon]

Ciear EnpressionBox | | TillniSatvnil =

Lise the avallable variables and the operators to bulld your exp

(ﬂ‘“k'ﬂ"“' ﬂ“m“l

Available EIA-176 variables When you click on a variable in the

[DIResSaICst] ﬁvanable box, then it will appear in the expression
[DIResSalCan] ox.
Click on variables to add to [DIComSalvol]
[DIComSalCan] your calculation.
Clear Expression Box MilndSaknl Click on operators to add + | <=add
Use the available variables and the operators t Ealieilali | <=Subtract
{check your syntax)
[DIResSalval o L
! | ==Divide
==left
e ( parenthesis
] ==right
parentheisi
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Use the available variahles and the operators to build your expression : {F:aferr:he Once
(check your syntax) ﬂ parrlf?rnhei yog’ve
[DIResSalval] + [DIComSalval] built your
Complete Expression expression,
click on
Complete your expression Complete

Expression

to finish.
Use the available variables and the operators to build your expression - ::i':;; You must name your
(check your syntax) ﬂ Daregm expression in

. [DIResSalol] + [DIComSalvol] AS the Enter a Column

Complete Expression Name box.

Add Another
Expression=>

TOTAL
Enter a Column Name
Finizhed == Run Query

If you want to add another expression click add Another Expression=>.

The expression box will be cleared out and you can start another expression. Your first expression will be
held for the query.

When you are finished, click Finished=> Run Query. This will immediately run the query.

Note: you can click and edit the expression in the expression box.

g=f Dynamic_Query : Select Query

ST COMPANYNAME Year | DIResSalVol |DI| D DIComSalfol | DIC| D DI D] DIl TOTAL

M| kS ABBYWILLE CITY OF 2000 4427 0411 824/ #1311213 2 5251
1A MOULTON MUN GAS SY35 2000 192530512 5900 H41 00 0 25143
1A BEDFORD CITY NAT GAS 2000 520140512 20794052 00/ 0 759093
IL  TOLEDO WILLAGE OF 2000 37026 05 12 12428 4041134 3 45454
IL | SIMS VILLAGE OF 2000 10257 04 12 330 #3300 0 10557

The columns have been resized and hidden (by clicking in the column headers) to show the TOTAL variable.
It is the sum of DLResSalVol And DIComSalVol.

Query : Select Query

COMPANYNAME Year DIResSalvol (DI DI DIComSalVal | DIC| D) DI D DI
IBYWVILLE CITY OF 2000 4427 04 824 {13 1 1213 2
QULTOM MUN GAS S5 2000 1926305 12 ogno0+H241 00 0
EDFDRD ClT"‘T" NAT GAS (nininl Cand A4 0o T ATOTO AL T On
JLEDO YILLAGE OF ElA-176 Query System E
M= YILLAGE OF

Do you want to zave changes to the layout of querny 'Diynamic_Huen"?

RAND TOWYER CITY OF
HAVNEETOWN MUN GAS
TTEBURG GAS CO

3ITA SPRINGE MAT GAS &
=W BOSTON MUN GAS 5Y3 2000 26343 05 12 4875/ H#14/1 00 0O

Mo Cancel

Because the columns were edited in the datasheet, this prompt appears after choosing the Close option
from the File Menu. Dynamic_Query is where user selected-queries are temporarily stored. It does
not matter if they are saved or not.
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After you close the query you're returned to the Select Quantities and build Calculated Items
Menu.

& User Selected Queries - Select Quantities and build Calculated Items

<=Back |

=10 =]

Make your type of operations and quantity selections before Add a Calculated

clicking Complete. Field == Complete=>
Aggregate functions AVErage ﬂ
Court
Sum -
4 I I L3
Select a Type of Investor Ovwwned distributor ﬂ
Operations municipally owned distributar
(default is N” Privately owned distributor
Co-op distributor =

Un-check available quantities to include or exclude quantites  Available Quantities Quantities to include =]
in you custom query in Query Output

Line Hum of Hum
Part Humber Description Vol Cost Consum Btu Mef vl Costof Btu Mcf
[T [o700][Total Suppty PO [ [ M oo e
[6 " [1010] [pet to Residential Sales | I (2 R I I R W
Ili_ Iﬁ |[Iel to Commercial Sales |‘|'_ |‘|'_ |‘|"_ I_ I_ (I T e I
Ili_ Iﬁ [Del to Industrial sales |‘|'_ |‘|'_ I'.'_ I_ I_ {2 I G I I
Ili_ IW [pel to Electric Power Sales I‘f_ I‘f_ I‘."_ I_ I_ | 2 R W
- BN N EE ey Eaf

To run the query you just constructed again you can click Run Query.

Exit returns you to the main queries menu.
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Appendix A — EIA-176 Survey Form
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Appendix B — Pre-Selected Query Items

Querydescription

QueryMemo

All Sector items sorted by state
Name and Address Information
Detail level Continuation Lines
Footnotes and Associated Data
Sector Vols sorted by sector
Sector Vols ranked nationally

Sector Vols sorted by company type

LNG & Underground Gas Storage
Sector Vols ranked by state
Sector Prices sorted by sector
Sector Vols for Investor Owned
Sector Vols for Municipally Owned
Sector Vols for Privately Owned
Sector Vols for Cooperatively
Sector Vols for Other Distribution
Sector Vols for Interstate Pipelines
Sector Vols for Intrastate Pipelines
Sector Vols for Storage Operators
Sector Vols for Synthetic Natural
Sector Vols for Producers

Sector Vols for Gathers

Sector Vols for Liquefied Natural
Sector Vols for Other Operators

EIA-176 Query System

This query includes company data sorted by state for lines 10.1 thru

This query includes the Company Name, State of Operation ,Type of
This query shows continuation lines with the company reference for Parts
This query shows data values and associated footnotes for selected

This query includes company data sorted by sector -Residential,

This query includes company data sorted by volume amounts.

This query includes company data

This Query has LNG and Underground Storage Injections & Withdrawals,
This query includes Company data sorted and ranked by volume amount
This query includes prices for consumption data - lines 10.1 thru 10.4,
This query includes only companies who checked A on Section Il. Type
This query includes only companies who checked B on Section Il. Type
This query includes only companies who checked C on Section II. Type
This query includes only companies who checked D on Section Il. Type
This query includes only companies who checked E on Section Il. Type
This query includes only companies who checked F on Section Il. Type
This query includes only companies who checked G on Section Il. Type
This query includes only companies who checked H on Section II. Type
This query includes only companies who checked | on Section Il. Type of
This query includes only companies who checked J on Section Il. Type
This query includes only companies who checked K on Section Il. Type
This query includes only companies who checked L on Section Il. Type
This query includes only companies who checked M on Section Il. Type
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Appendix C — User Selected Query Item names

UserQueryName

| uQPart |uQLin|

Gas Produced onsystem by company
Synthetic natural gas produced
Underground Storage Withdrawals
Received from LNG

Other Storage Withdrawals
Transported into rpt ST from: ST or Cntry
Receipts at City Gate

Other Receipts

Supplemental Gasous Fuels

Total Supply

Inventory of LNG

Heat Content of consumer deliveries
Del to Residential Sales

Del to Commercial Sales

Del to Industrial sales

Del to Electric Utility Sales

Del fo Vehicle Fuel

Del to Other (see footnotes for type)
Trans to Residential Consumers
Trans to Commercial Consumers
Trans to Industrial Consumers

Trans to Electric Utilities

Trans for Vehicle Fuel use

Trans to Other (see footnotes for type)
Pipeline Compressor Use

New Pipeline Fill

Distribution Company Use

Other (see footnotes for type)
Underground Storage Injections
Liguefied natural gas (LNG) Injections

Other Storage Injections (see footnotes for type)

Trans to State Line: Comp ST/Cntry
Lease Use
Returned to oil and/or gas reservoirs

Losses from leaks, migration, damage and/or

Other Disp: Distribution Companies
Other Disp: Other Pipelines

Other Disp: Storage Operators
Other Disp: Other (Specify type)
Total Disposition

Unacc't for gas supply

EIA-176 Query System

D OO OO O OO OO oo hdd™bMbdMMSbAbEAAPd

1/26/04 -

0110
0120
0210
0220
0230
0300
0400
0500
0600
0700
0800
0900
1010
1020
1030
1040
1050
1060
1110
1120
1130
1140
1150
1160
1210
1220
1230
1240
1310
1320
1330
1400
1500
1600
1700
1810
1820
1830
1840
1900
2000
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